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SE3D One-Year Limited Warranty 

This Limited Warranty applies to new and refurbished r3bEL bioprinters (the “Product”) sold by SE3D, Inc. (SE3D) or a 

current authorized reseller of Products and Smart Extruders (collectively “Authorized Party” or “Authorized Parties”). 

(A) LIMITED WARRANTY. SE3D represents and warrants to the first end-user (“End-User”) of Product that the Product shall 

materially conform to SE3D’s published specifications in the user manual, subject to the terms and conditions below. 

(B) FOR A WARRANTY CLAIM TO BE VALID. (i) notification must be made before the end of the Warranty Period, as defined 

below; (ii) must accompany customer logs and/or any other documentation if requested by SE3D; and (iii) must be 

substantiated with original proof of purchase from an Authorized Party, including the serial number of the Product(s). 

(C) CLAIM HANDLING. (i) the remedy shall be repair or replacement of the non-conforming hardware SE3D or non-

conforming part(s) of a hardware Product in a commercially reasonable time by SE3D or its authorized representative as 

solely determined by SE3D or its authorized representative; (ii) SE3D shall bear the cost of repair and/or replacement and 

the shipping costs incurred therein provided, however, that the return is authorized via an RMA number and return 

instructions are followed; (iii) replacement parts or Products will either be new or refurbished and will be furnished on an 

exchange basis. If defective Parts or Products are not returned, SE3D shall bill for the unreturned hardware. All replaced 

parts or Products become the property of SE3D. Consumable parts not covered are: Biokits, SD card, syringe holder tabs, 

acrylic plate and glass plate. (“Consumables”, defined as disposable items, parts or components of the Product which are 

inherently subject to deterioration and wear out during the normal operation of the Product.) 

(D) WARRANTY PERIOD. One-year from the date a new or refurbished Product is first delivered to the End-User after being 

purchased. 

(E) EXCLUSIONS. The limited warranty obligations do not cover physical damage sustained from improper handling during 

shipping as well as normal wear and tear in use of Product. The limited warranty shall be voided if alleged Product failure 

was caused in whole or part by (i) improperly or incorrectly performed modifications, alterations or repair; (ii) parts or 

consumables were installed and used that were not certified or approved by SE3D or its designated representative; (iii) 

unusual physical or electrical stress; (iv) abuse, misuse, accident, neglect; (v) exposure to excessive water, flooding, fire, 

electrical problems associated with incoming power or other acts not the fault of SE3D; (vi) not adhering to SE3D’s 

recommended maintenance procedures or failure to comply with Product instructions and/or documentation; (vii) to the 

extent allowed by applicable law, the Product has been removed from the country or region where it was originally sold 

by SE3D or its designated representative. No coverage under the Limited Warranty will exist if SE3D was not notified of 

the alleged defect or malfunction prior to the expiration of the Warranty Period. SE3D shall make the final determination 

as to the existence and cause of any alleged defect. 

(F) LIMITATIONS/DISCLAIMERS. This limited warranty is the end-user’s sole and exclusive remedy against SE3D where 

permitted by law. Except for this limited warranty, SE3D makes no other warranties whether expressed or implied by law, 

course of dealing, course of performance, usage of trade or otherwise, with regard to the performance of any product. 

Without limitation of the foregoing, all implied warranties, including warranty of merchantability or fitness for a particular 

purpose, are hereby excluded. SE3D waives all liability for any indirect, incidental, collateral, exemplary, punitive, special 

or consequential damages, including loss of use or loss of profits, even if SE3D has been advised of the possibility of such 

claims or damages. SE3D reserves the right to modify or update without obligation to replace any Product delivered prior 

to any such change.  

 

(G) HOW TO GET WARRANTY SERVICE. To make a claim under this Limited Warranty, please contact the Authorized Party 

where the Product was purchased, or, contact SE3D Support via email support@SE3D.com. Support is available 9am to 

5pm PST Monday through Friday. 

(H) EXTENDED WARRANTY. Customers can choose to purchase a 2-year extended warranty within 90 days of purchasing 

the Product. To purchase extended warranty, please visit www.se3d.com/warranty 

mailto:support@SE3D.com
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1 r3bEL mini Overview 

 
 

 

 

Printer axis 
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2 Safety Precautions 
Please read this section carefully before using the printer. 

2.1 General Safety 

● The r3bEL bioprinter should only be used with the supplied power adapter to avoid the risk 

of fire or damage to the bioprinter. 

● Wires carrying current will be running at 120V AC or 12V DC and can cause electric shock if 

tampered with. 

● Loose clothing or hair should be secured prior to using the bioprinter to prevent being 

caught in moving parts of the machine. 

● When handling syringes, especially with sharp needle tips, extra care should be taken to 

avoid poking or stabbing yourself. 

● Use only blunt tip syringe needles for all bioprinting activities.  

● For disposal and handling of biohazardous waste or contaminated items, please reference 

and follow the safety guidelines for the laboratory. 

 

2.2 Protection 

● The r3bEL bioprinter should not be exposed to excessive liquid or damage may occur. 

● Do not shut down the bioprinter or pull out the microUSB cable when loading a digital 

model, or the model data may be lost. 

● Do not load the syringe before homing the printer. 

● When priming make sure there is a gap distance of at least 30 mm between the needle tip 

and bed to allow smooth flow of the material. 
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3 Accessory Checklist 

 

Your r3bEL mini bioprinter will arrive with the following accessories: 

 

1. User Guide and bed templates 

● One petri dish bed template  

● One well-plate bed template  

2. Power supply cable 

3. Accessory bag 

• 5 mL Syringe 

• 22 Gauge Needle 

• Micro USB Cable and SD card reader 

4. Allen wrench 

 

Be sure to remove all packaging from the bioprinter before use. 

 

3.1 Additional Items 

You will be provided with a 5 mL syringe and 22 gauge blunt-tip needle to use with your bioprinter 

for initial testing. You can purchase additional consumables at our website se3d.com 

 

  

https://www.se3d.com/
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4 Software Installation 
You can control the r3bEL mini bioprinter through a USB cable or wirelessly through Wi-Fi. Follow 

the instructions according to the operating system you have on your computer and the choice of 

USB or Wi-Fi connection to the r3bEL mini bioprinter. 

4.1 USB Control 

Complete all 3 steps for software installation to ensure that the bioprinter will connect to your 

laptop or computer. You can download all the software programs, print files and find our user 

manual including video instructions in the SE3D Portal - http://portal.se3d.com. Please create a 

user account to access all the supporting documentation and materials.  

4.1.1 Step 1: Download Printer Control Software 

Pronterface is a free open-source 3D printer control software that controls and operates a 3D 

printer. This software will be used to control the r3bEL mini bioprinter via USB. 

Follow these instructions to download the software: 

1. Go to portal.se3d.com and click on Log In in the top right corner and register. 

2. Once you have registered, you will get a confirmation email with a link to activate your 

account. After you activate your account, you will have access to Startup Guide and 

Troubleshooting sections. 

3. On the portal main site, scroll down to Teacher Resources and click on Startup guide. 

Select the r3bEL mini folder and navigate to “Programs to Download section” and 

depending on the operating system of your computer download the PC or macOS folder 

by clicking on it. 

4. Once the zip file is downloaded, extract the contents to a folder where you want the 

program to reside.  

5. Locate the Pronterface application and double click to open this program. 

The application should appear as shown below: 

 

http://portal.se3d.com/moodle/
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4.1.2 Step 2: Download Arduino IDE 

You must install the Arduino software before connecting to the printer, so that the correct device 

drivers are installed. For installation of Arduino IDE, you must go directly to their website:  

1. Go to https://www.arduino.cc/en/Main/Software 

2. Choose your operating system from the box shown below: 

 

 

 

3. Click “Just download” from the contribution page (unless you want to contribute). 

 

 

 

https://www.arduino.cc/en/Main/Software
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4. Once the file is downloaded, the contents of the folder must be extracted, which can be 

done in two ways: 

a. Find the file in your Download folder. Right-click and select “Extract All,” then 

select a folder destination and click “Extract.”  

b. Find the file in your Download folder. Open the zip file. Drag and drop the folder 

called “arduino 1. … ” to your Desktop. 

 

5. The next step is to install the drivers. Go to Tools > Boards> Boards Manager 
 

 
 

a. In the Boards Manager pop-up widow, type “Arduino Due” in the search box and 

select the result titled “Arduino SAM Boards (32-bits ARM Cortex-M3)” and click 

“Install” as shown below. 

 



 r3bEL mini User Manual  

11 

  

 

6. Once the installation is complete, go to Tools > Board, scroll down and select “Arduino 

Due (Native USB port)” 

 

 

4.1.3 Step 3: Download Slic3r  

Slic3r is a free open-source slicing software that will slice a 3D model into g-code files for printing. 

This software can provide g-code files for creating 3D models to print on the r3bEL mini 

bioprinter. However, please note that the configuration files for bio-printed models are distinct 

from those used for regular 3D printing. You must load the config file provided by SE3D when 

using Slic3r. Follow the instructions below for installation of program and config files. 

You should find the Slic3r program in the Programs to Download zip file when you downloaded 

Pronterface earlier.  

To download the Config files for Slic3r settings, go to Startup guide – r3bEL mini and click on the 

Config files folder to download this folder. Extract the contents to a folder in your computer. 

 

Click on Slic3r to install the program. Once the Slic3r program installation is completed, for PC 

and macOS users, open the program and follow the configuration wizard: 
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1. You will first be prompted 

with the Welcome screen. 

Click Next. 

 

 
2. For G-code flavor, select 

RepRap (Marlin/Sprinter/ 

Repetier). 

 
3. For Bed Size, use the 

default x = 120 and y = 130 

setting since our print bed 

is 120 x 130mm. 
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4. Set the nozzle diameter to 

0.5 mm. 

 
5. Set the filament diameter 

to 3 mm. 

 
6. Set extrusion temperature 

to 0°C since there is no 

heating element on the 

r3bEL mini bioprinter tool 

head. 

 
7. Set bed temperature to 0 

and click next. Then finish. 
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Once you have completed the configuration wizard, the Slic3r program should look like this: 
 

 
 
 

Now, to load the “lotion” config file by following these steps: 

Note: we use lotion as the mock biomaterial to perform baseline tool calibration 

1. Go to File > Preferences 

(for Windows users).  

For macOS users, to go 

Slicer > Preferences 
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2. The Preferences window 

will pop up. Under Mode, 

select Expert.  

Click OK to exit the 

window. 

 
 

Once you have changed the preferences, you will need to restart the program for the changes to 

take effect. Close and relaunch the Slic3r program. 

Notice that you now have a new print settings tool bar on your right panel after you restart the 

program (see below): 

 
 

The default settings for Print settings, Filament and Printer are all currently set as Simple Mode 

when you first set up your bioprinter. We do not recommend using this config file to print any 

model at this point. Each material that you will use for the r3bEL mini bioprinter will require its 

own unique set of parameter settings.  You will learn more about these features and parameters 

when you go through our bioprinter lab modules.  
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If you are a previous 3D printer user and already have Slic3r installed on your computer, please 

note the warning below: 
 

 
 

Next, to load the “Lotion” config file (.ini file type) that you extracted previously. Follow steps 

below for installation: 

1. Go to File > Load Config… 

 
2. Select the Lotion.ini file 

and click Open. 

 

 

WARNING 

Do not use the default configuration settings in Slic3r. The default settings 

will cause the extruder to heat to high temperatures and melt your syringe. 

Ensure that you have loaded the “lotion.ini” config file prior to your first print.  
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3. You should now see that 

your printer, filament and 

print settings on the right 

panel have all changed to 

Lotion.ini instead of the 

default settings.  

 
4. Save the lotion settings in 

each Slic3r tab so that it 

becomes the default by 

clicking the save button in 

the upper left corner in 

each of the settings tabs. 

 

 
 

As a final check to ensure that your temperature settings on Slic3r is correct, click on the Filament 

Settings Tab. Make sure you are looking at the lotion config file and check that your temperature 

settings match the settings shown below:  
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4.2 Setting up Pronterface 

1. Connect the provided power cable and microUSB cable to the power and microUSB 

ports on the rear of the bioprinter. 

2. Turn on the bioprinter using the power switch. 

3. Connect the microUSB cable to a USB port on your computer and wait for the device 

drivers to install. 

4. Open Pronterface. 

5. Familiarize yourself with the interface by recognizing each feature and function as 

listed below: 

 

 
 

A. Port Selection 

B. X, Y, Z Control Panel 

C. Heater Control (Note: this feature is not used on the r3bEL mini) 

D. Extruder Control 

E.        Custom Button Area 

F.        Command Line 

G. Command Window 

 

6. To connect the bioprinter to Pronterface, select the proper COM port. This will be 

whatever port your computer assigns the device to. In macOS, ports may have a 

different naming designation similar to “/dev/ttyUSB0” or “/dev/ttyACM0.”  

7. Click the “Connect” button. If successful, the command window should display “Printer 

is now online” and the buttons should activate/no longer be grayed out. 

 

 

 

B 

C 

D E 
F  

G 

 

 

 

 

A 
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8. To test the motors, use the circular control pad to move the X and Y motors. The 0.1, 

1, 10, and 100 increments represent actual distances in millimeters. 

 

 
 

X-Y-Z coordinate system on r3bEL mini 

X-coordinate: 

The X-motion moves the extruder head left or right. +X will move the extruder head to 

the right relative to the user facing the front of the printer and –X will move the 

extruder head to the left. 

 

Y-coordinate: 

The Y-motion moves the bed (Note: The motion of the bed is relative to the extruder 

head). +Y will move the bed to the front relative to the head so the extruder head will 

shift toward the back of the bed and -Y will move the bed to the back relative to the 

head, so the extruder head will shift toward the front of the bed. 

 

Z-coordinate: 

The Z-motion moves the bed up and down. Use the control bar on the right to move 

the platform in the Z direction. It is important to note that +Z will cause the platform 

to move down, increasing the distance between the extruder and the platform bed. -Z 

will move the platform up, decreasing the distance between the extruder and the 

platform bed. 
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9. Without placing a syringe in the extruder unit, press the white Home All button at the 

bottom left circular control pad. This will home all three axes of the printer. 

 

4.3 Custom Buttons  

In Pronterface, you have the capability to create your own custom buttons. This will allow you to 

perform common tasks at the click of a button instead of having to manually enter codes every 

single time in the command line. Proceed to create these custom buttons for r3bEL mini. 

To add a button, click on the “+” box in the custom button area (you will find this at the bottom 

of the yellow gridded print area shown below).  

 

 

A text box will appear; fill in each setting accordingly to create customized buttons on your 

Pronterface software. 

 

ROW 1             
Button title: Set Home   Button title: Set Z0 

Command: G92 X0 Y0 Z0   Command: G92 Z0 

Color:  #cccccc   Color:  #cccccc 
 

Button title: Get Position   Button title: Move to Front 

Command: M114    Command: G1 X0 Y52 F6000 

Color:  #cccccc   Color:  #cccccc 
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ROW 2             
Button title: P0    Button title: P1 

Command: G1 X-48 Y-52 F6000  Command: G1 X-48 Y52 F6000 

Color:  #66b3ff   Color:  #66b3ff 

 

Button title: P2    Button title: P3 

Command: G1 X48 Y52 F6000  Command: G1 X48 Y-52 F6000 

Color:  #66b3ff   Color:  #66b3ff 

 

 

ROW 3             
Button title: Extrude 150 mm  Button title: Extrude 50 mm 

Command: G1 E150 F3000  Command: G1 E50 F3000 

Color:  #33cc33   Color:  #5cd65c 

 

Button title: Extrude 5 mm   Button title: Extrude 1 mm 

Command: G1 E5 F3000   Command: G1 E1 F3000 

Color:  #85e085   Color:  #c2f0c2 

 

ROW 4             
Button title: Retract 150 mm   Button title: Retract 50 mm 

Command: G1 E-150 F3000   Command: G1 E-50 F3000 

Color:  #ff4d4d    Color:  #ff6666 

 

Button title: Retract 5 mm    Button title: Retract 1 mm 

Command: G1 E-5 F3000    Command: G1 E-1 F3000 

Color:  #ff8080    Color:  #ffb3b3 

 

When you are finished, the final custom button setup should look like this: 

Custom Button Setup 
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4.4 Understanding the Custom Button Functions 

 
Button Name Function 

Set Home This sets a new home (0,0,0) position for your r3bEL mini printer. This 

function serves as a manual override to the default setting, such as for 

adjusting the home position based on differences in needle tip heights. Note 

that once you turn off the printer or use the Home All function, the home 

position will restore to the factory default. 

Set Z0 The Set Z0 button adjusts the Z-height home position only but is similar to 

the Set Home button in that it serves as a manual override. Note that once 

you turn off the printer or use the Home All function, the Z0 position will 

restore to the factory default. 

Get Position This button provides the exact x, y and z position of your printer. The readout 

will appear in the command window. 

Move to Front This button moves the extruder to (0,52) along the xy plane. 

P0, P1, P2 and P3 These buttons move the extruder to each of the 4 calibration points on the 

printer at the respective corner x-y positions. P0 is at (-48,-52), P1 is at (-

48,52), P2 is at (48,52) and P3 is at (48,-52).  

Extrude 150 mm This button moves the extruder plunger down by 150 mm in distance, 

extruding whatever liquid or material is in the syringe. 

Extrude 50 mm This button moves the extruder plunger down by 50 mm in distance, 

extruding whatever liquid or material is in the syringe. 

Extrude 5 mm This button moves the extruder plunger down by 5 mm in distance, extruding 

whatever liquid or material is in the syringe. This is useful for priming the 

needle when the extruder plunger is already in contact with your syringe 

plunger. 

Extrude 1 mm This button moves the extruder plunger down by 1 mm and is useful for very 

small increments of extrusion. 

Retract 150 mm This button moves the extruder plunger up by 150 mm. This is often used 

when you want to unload a syringe. 

Retract 50 mm This button moves the extruder plunger up by 50 mm.  

Retract 5 mm This button moves the extruder plunger up by 5 mm. This is useful for 

alleviating pressure buildup in the syringe needle tip (for small needle tips). 

After a print, retracting by 5 mm can prevent material from dripping or oozing 

from the needle tip. 

Retract 1 mm This button moves the extruder plunger up by 1 mm for very small 

increments of motion. 
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5 Connect via Wi-Fi 

5.1 Printer Driver Installation (Windows) 

The Duet drivers ensure that the computer recognizes the bioprinter and that you do not have 

any connection issues when you connect the printer. If you are running Windows operating 

system follow the steps below, omit this step if your computer runs on operating system other 

than Windows.  

1. To download the Duet driver files, go to the Startup-guide – r3bEL mini, scroll to the 

“Programs to download” section and download the Duet Driver file. Unzip the two files 

(duet.inf and duetinf.cat) to a local folder on your PC. 

2. Connect the Duet to your PC using the USB cable. 

3. Open Device Manager. Find the Ports section and identify the device that shows up 
when you connect the bioprinter.  
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4. Right-click on the Device and select Update Driver Software as shown below.  

 

5. Click on Browse my computer for driver software option and choose the folder where 
you extracted the files from the DuetWiFi driver.zip folder and click on Next. 
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6. You will get a Windows installer pop-up window click on Install and wait until it says 
Windows successfully updated the driver software and click on close. 

 

7. Once you close the window you should see that the Unknown device should show up as 
DuetWifi or Duet Ethernet 3D Printer control electronics (COM). 
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5.2 Configuring the Wi-Fi 

To setup the Wi-Fi connection you must download YAT terminal (for Windows) or Coolterm (for 
macOS) depending on the operating system of your computer. Windows users can follow the 
instructions listed under section 5.2.1 YAT Terminal and macOS users can skip to section 5.2.2 for 
instructions. 

5.2.1 YAT Terminal (Windows) 

YAT terminal software is used to configure the Wi-Fi module on the bioprinter. If you are running 
a Windows operating system follow the steps below: 

1. Download the Terminal Emulator program YAT from the link 

https://sourceforge.net/projects/y-a-terminal/ and install the software. 

 

2. Make sure that the bioprinter is connected to the computer using the USB Cable. 
 

3. Open the program and click on OK in the New Terminal window. Make sure that the 
board is recognized in the pop-up window as shown below. 
 

 

https://sourceforge.net/projects/y-a-terminal/
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4. You will now be able to send commands to the board by typing it in the Send Text 

command box. Send the following command:  

 
M552  

 
Wait until you get the "Wi-Fi module is idle" reply: 
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5. Next, send the following command to save the access point parameters: 
 

M587 S”Name of the Wifi you want to connect to” P”Password for the network” 

Note: The Wi-Fi module operates at 2.4 Ghz not 5 Ghz. Make sure you enter the details 
for the 2.4 Ghz network. The Name and Password for the network are case sensitive so 
make sure that you enter the details carefully! 
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6. To verify that the network you entered has been stored, send:  
 

M587 

This command will display a list of networks it has been connected, the last one is the 
most recent network. You can set up connection to additional access points in the same 
way if you wish. 
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7. Send the following command to connect to the access point: 
 

M552 S1 
 

After a few seconds, it should confirm the connection and give you an IP address. If you 
have configured multiple access points and more than one is in range, the bioprinter will 
connect to the strongest one.  
 
Note: Remember to take down this IP address since you will need it to connect to the 
printer. 
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5.2.2 Coolterm (macOS) 

Coolterm is used to configure the Wi-Fi module on the bioprinter for MacOS users. If you are 
running a MacOS operating system follow the steps below: 

1. Download the MacOS version of the Terminal Emulator program Coolterm from the link 

http://freeware.the-meiers.org/ and extract the contents to a local folder. If you get an 

error “can’t be opened because it is from an unidentified developer” when you try to 

open the software, go to Settings>Security/Privacy and you should have an option to 

allow all apps, this will make it a trusted app. 

 

2. Make sure that the bioprinter is connected to the computer using the USB Cable. 
 

3. Open the program and click on options. Select the dropdown in the Port option and 
choose the one with the name similar to “usbmodem145411”. The numbers might differ 
each time. 

 

http://freeware.the-meiers.org/
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4. Choose the Terminal section and under Terminal Mode choose the Line mode and click 
on OK. 
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5. Click on Connect in the main window and send the following command and wait till you 
get the output “Wifi module is idle”: 
 

M552 
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6. Next, send the following command to save the access point parameters: 
 

M587 S”Name of the Wi-Fi you want to connect to” P”Password for the network” 

Note: The Wi-Fi module operates at 2.4 Ghz not 5 Ghz. Make sure you enter the details 
for the 2.4 Ghz network. The Name and Password for the network are case sensitive make 
sure that you enter the details carefully. 
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7. To verify that the network you entered has been stored, send:  
 

M587 

This command will display a list of networks it has been connected, the last one is the 
most recent network. You can set up connection to additional access points in the same 
way if you wish. 
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8. Send the following command to connect to the access point: 
 

M552 S1 
 

After a few seconds, it should confirm the connection and give you an IP address. If you 
have configured multiple access points and more than one is in range, the bioprinter will 
connect to the strongest one.  
 
Note: Remember to take down this IP address since you will need it to connect to the 
printer. 
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5.3 Web Control Interface 

Enter that IP address you got when you configured the Wi-Fi in the browser address bar on your 
PC, tablet or smartphone to connect. The web control works best in Google Chrome and Firefox. 
When you connect, it will prompt you for a password, enter se3d and hit enter. The interface will 
look like: 

 
 
 

1. Familiarize yourself with the Web control options: 
a. Machine control: Enables you to control the Printer and extruder movements 
b. Print Status: Shows the status of the file being printed. Enables you to pause/ 

resume your prints. 
c. G-code console 
d. G-code files: The g-code files uploaded in the SD card 
e. Macros: User defined custom macros 

2. Printer movement control  
3. Extruder control 
4. User defined custom buttons  

1 

3 

4 

2 
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6 Setting up for Printing 

6.1 Loading and Unloading Syringes 

Before loading or unloading syringes, ensure that the r3bEL mini bioprinter is connected to your 

computer via USB and open the Pronterface program.  

 

6.1.1 Loading a syringe 

1. Insert the barrel flanges into the barrel flange slot and try to align the syringe plunger to fit 

in the slot in the extruder (see figure below). If the extruder slot does not align with the 

syringe plunger move the extruder higher or lower by clicking on “extrude” or “retract” 

accordingly until the slot in the extruder aligns with the syringe plunger. Then slowly push 

the syringe in until it locks into position on the metal holder.  

2. After the syringe is in place extrude in 5 or 1 mm increments until liquid is pushed out of 

the needle tip. This is referred to as “priming” the syringe. Wipe off any excess liquid before 

printing. 

 

6.1.2 Unloading a syringe 

1. Retract the extruder by 5 mm or 1 mm to make sure that the syringe plunger is loose and 

not in contact with the top of the extruder. 

2. Pull the syringe slowly and you should be able to get the syringe out smoothly. 
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7 Your First Print 
You are now ready to run your first test print. Follow the instructions below to perform the first 

print on your new r3bEL mini. We recommend doing this via USB connection using Pronterface 

since this will be your first time.  

 

Required Items: 
● r3bEL mini bioprinter 

● Petri dish (100 mm diameter) 

● 5 mL plastic syringe 

● 22-gauge blunt-tip needle with Luer lock 

● Lotion  

 

Procedure: 
1. Turn on the r3bEL mini bioprinter and connect via Pronterface. 

2. Home the bioprinter using the Home All button. 

3. Fill a 5 mL syringe with ~4 mL of lotion. 

4. Load the syringe in the extruder. 

5. Prime the syringe, which will help ensure print consistency. Manually extrude in small 
increments using the “Extrude 5 mm” or “Extrude 1 mm” button until lotion is pushed out 
of the needle tip. Wipe excess lotion away as necessary from the needle tip. 

 

 
 

6. Set the Z0 position using the Set Z0 custom button. Manually move the bioprinter bed using 
the Z axis control buttons until it is almost in contact with, but not touching, the needle tip. 
Verify the positioning by sliding a piece of paper between the needle tip and bed. Adjust 
the bioprinter bed until the piece of paper can slide between the needle tip and bed with 
only minimal resistance, then click the Set Z0 button.  

 
7. Download the Bone mini-5ml-22g.gcode file from the SE3D portal if you haven’t already 

done so. This file can be found in the G-codes files section in the Startup Guide – r3bEL mini. 
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8. In the top toolbar of Pronterface, click Load File. Choose the Bone mini-5ml-22g.gcode  file. 
To load and print your own files, simply use the Load File button, as shown in this example. 

 

 
 

9. Click the Print button to start your print in Pronterface. The print should look similar to 
the picture below. 
 
Note: If the extruder or bed hits the Needle tip/Petri dish/Well plate or rams into the 
sides of the printer, turn off the main power switch in the bioprinter. 
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8 Shutdown Procedure 
1. Click the Disconnect button on Pronterface, then exit the application. 

2. Unplug the microUSB cable from your computer. 

3. Turn off the bioprinter. 

 

EMERGENCY SHUTDOWN: In the event of an emergency, use the power switch on the back of 

the bioprinter. Turn off the bioprinter immediately for any of the following reasons: 

● Extruder is repeatedly ramming into sides of printer 

● Extruding excessive amount of liquid 

● Extruding or retracting past the limits of the extrusion unit 

● Extrusion unit is moving past its limits (hitting sides of printer) 

● Heater malfunction (too hot, burnt smell, etc.) 

● Wiring malfunction (short circuit, burnt smell, etc.) 

● Any other situation that could harm the printer or user 

 

Warning: When you turn off the power to the printer, the bed will drop down immediately.  
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9 Maintenance 

9.1 Calibration Guide 

The HOME position is set to be the center of the bed, and is defined as (0, 0, 0).  

If the X, Y and Z axes did not home properly after you received and set up your bioprinter, or if 

you wish to recalibrate the bioprinter, follow the steps below to properly set new XYZ coordinates 

for your printer. This guide will also cover resetting the bed leveling plane. 

Resetting XYZ Coordinates 

To reset the XYZ coordinates, you will need to be connected to your bioprinter via Pronterface 

and have your microSD card adapter ready. 

1. Home all axes by clicking the Home All button in Pronterface. 

2. In the G-code console command line, type the following command: 

G92 X0 Y0 Z0 

This will manually set this position to (0,0,0), but will not return a response in the command 

window. Proceed to next step to check that it was successful. 

3. Press the Get Position button to check the position. This should return the following: 

>>>M114 

SENDING:M114 

X:0.00 Y:0.00 Z:0.00 ……………… 

Verify the values as are shown in the highlighted portion above. 

4. Using the control pad, move the extruder along the X and Y axes such that the physical 

position is at (0,0) as shown below. Then, move the bioprinter bed up (-Z) or down (+Z) 

until it is at the height shown: 

 

                                        

 

(0,0) 
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5. Click the Get Position custom button to obtain the actual physical position of (0, 0, 0) 

relative to the previous incorrect position of (0,0,0). For example: 

>>>M114 

SENDING:M114 

X:1.1 Y:0.7 Z:-0.9 ……………… 

 Record the results below: 

X    Y    Z     
 

6. Turn off the bioprinter and unplug the microUSB cable. Remove the microSD card from 

the controller board and using the provided microSD card adapter, plug it into your 

computer. 
 

7. In the microSD card’s sys folder, open the config file (sys > config.g) in a text editor 

program. 
 

8. Navigate to the M208 commands, which should be clearly labeled in the CALIBRATION 

section of the file: 
 

 

a. There will be two M208 lines: 

i. The top line is used to adjust the Z height 

ii. The bottom line is used to adjust the X and Y coordinates 

b. For the Z height, subtract the value you recorded in step 5 from 0 and add it to 

the existing value. For example, if you have “-0.9” listed above and the value in 

the file is “Z46”, you will subtract -0.9 from 0 which is 0.9 and add it to “Z46” and 

the new value is “Z46.9”. 

c. For the X and Y positions, subtract the value you recorded in step 5 from 0 and 

add it to the existing value like you did for the Z axis. For example, if you have 

“1.1” listed above and the value in the file is “X-48.9”, you will subtract 1.1 from 

0, which is -1.1 and add it to “X-48.9” and the new value is “X-50”. 
 

9. Save the file and place the microSD card back in the controller board. 

 

10. Restart the bioprinter and reconnect in Pronterface. Click the Home All button. Verify that 

the bioprinter has homed correctly. If it is still not at the correct position, repeat steps 2-9. 
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9.2 Resetting Bed Leveling Plane 

To reset the bed levelling plane, you will need to be connected to your bioprinter in Web Control 

and have your microSD card adapter ready. 

1. Home all axes by clicking the Home All button in Pronterface. This will bring the extruder 

to (0,0,0). Press on the P0 button under the user defined macros section and it will move 

the head to (-48,-52,0). 
  

2. Ensure you are at the right position by clicking the Get Position custom button and 

verifying the response in the command window. 
 

3. To obtain and record the Z values at 4 probe points around the bed for resetting the bed 

levelling plane follow the below steps and use the space below to record your Z values: 
 

 P0      0.0                P1      P2   P3    

a. Manually decrease the Z height (-Z) until the needle tip is almost touching the 

bed. Click on Set Z0 and note down the value in P0. 

b. Manually lower the bioprinter bed (+Z) by 3mm using the control panel. 

c. Press the custom button P1 to move the extruder to the first probe point. 

d. Manually decrease the Z height (-Z) until the syringe tip is almost touching the 

bed (same needle height as at P0). 

e. Click the Get Position button and record the Z height for P1. 

f. Increase the Z height 3mm, press the P2 button to move to P2, and lower the Z 

height until the syringe tip reaches the same height as the other two points. Click 

Get Position and record the Z height for P2.  

g. Increase the Z height 3mm, press the P3 button to move to P3, and lower the Z 

height until the syringe tip reaches the same height as the other two points. Click 

Get Position and record the Z height for P3.  
 

4. Turn off the bioprinter and unplug the microUSB cable. Remove the microSD card from 

the controller board and using the microSD card adapter, plug it into your computer. 
 

5. In the microSD card’s sys folder, open the bed.g file in a text editor program. Input your 

new recorded Z values. An example is shown below: 

  

6. Save the file and place the microSD card back in the controller board. 
 

7. Restart the bioprinter and reconnect in Web control. Click the Home All button. Verify 

that the bioprinter bed levelling is correct. It not, repeat steps 2-7. 
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9.3 Cleaning the printer 

Follow the below steps to clean the printer: 

1. For general cleaning, use a damped cloth to clean the outer panels of the printer. In the 

event it gets soiled or stained, you can use a mild detergent (preferably diluted) to clean 

off any stain. 

2. Do not spray the cleaning solution or water directly on the printer. Spray it on a 

paper/cloth and use it to clean the outer panels. 

3. If you wish to sterilize the bioprinter for tissue culture purposes, you can use 70% 

ethanol to wipe down the surfaces. Spray on a paper towel and use this to wipe down 

the printer exterior. 

4. You can wash the acrylic bed with warm water and soap in the event it gets soiled. If 

you wish to sterilize it, you can spray it with 70% ethanol or autoclave the acrylic bed 

templates. 

10 Advanced Settings 

10.1  G-code Adjustments 

G-code is a programming language that allows your computer to communicate with your 3D 

printer, it provides the instructions to tell the 3D printer what to do and how to move. This section 

outlines the relevant commands used to control the r3bEL mini bioprinter.  

A full reference guide for G-codes can be found at http://reprap.org/wiki/G-code.  

G1: Move 

Usage 

G1 Xnnn Ynnn Znnn Ennn Fnnn Snnn 

Parameters 

Not all parameters need to be used, but at least one has to be used 

Xnnn (The position to move to on the X axis) 

Ynnn (The position to move to on the Y axis) 

Znnn (The position to move to on the Z axis) 

Ennn (The amount to extrude between the starting point and ending point) 

Fnnn (The feedrate per minute of the move between the starting point and ending point, 
if supplied) 

Example 

G1 X10 Y15  (Move to position X=10 and Y=15) 

 

 

http://reprap.org/wiki/G-code
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G4: Wait 

Usage 

G4 Pnnnn 

Parameters 

Pnnn Time to wait, in milliseconds 

Example 

G4 P2000 (Wait 2000 milliseconds (2 seconds) before next command) 

 

G21: Set Units to Millimeters 

Example 

G21 (The software default is in millimeters, but this is still good to know) 

G90: Set Absolute Positioning 

Example 

G90 (All coordinates from now on are absolute relative to the origin of the machine) 

G91: Set Relative Positioning 

Example 

G91 (All coordinates from now on are relative to the last position) 

G92: Set Position 

Usage 

G92 Xnnn Ynnn Znnn Ennn 

Parameters 

This command can be used without any additional parameters. 

Xnnn new X axis position 

Ynnn new Y axis position 

Znnn new Z axis position 

Example 

G92 X0 Z0 (Set X position to 0 and Z height to 0) 

 

10.2  G-code Customization 

For Array Printing 

To customize your own G-code files for new materials or to adjust existing files, here are some 

basic guidelines you can follow. In general, higher viscosity fluids will require larger extrusion 

amounts to release a droplet from the needle tip and more time for the droplet to release. 
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Below is a table of recommended extrusion commands to have a droplet release from the needle 

tip for different materials. All testing was done for printing a 3x3 array using a 22-gauge needle 

tip. 

The parameters being changed are extrusion volume (G1 E### F###), extrusion speed (G1 E### 

F###), retraction volume (G1 E-### F###), retraction speed (G1 E-### F###), and wait time 

between drops (G4 P####). 

Water G1 E1.6 F200 

G1 E-0.3 F50 

G4 P1000 

Alginate (1% w/v) G1 E2.4 F200 

G1 E-0.8 F200 

G4 P3000 

ABTS solution G1 E1.7 F200 

G1 E-0.4 F50 

G4 P1000 

After adjusting your G-code file for the new material or protocol, test it out on the bioprinter and 

observe the prints. If you still experience some issues as those described below, follow the 

instructions to troubleshoot and modify your protocol. 

Drop not releasing from needle tip 

This indicates that there isn’t enough liquid is being pushed out of the syringe. This can be fixed 

by increasing the E distance in the G1 command. 

Two drops releasing from needle tip 

This problem can happen for two reasons:  

Problem Solution 

The previous drop did not release See issue above 

The E amount is too high Decrease the E amount in the G1 command 
 

Can’t get consistent droplets even with new values 

If this is the case, then it is probably a good idea to adjust the retraction amount. The retraction 

command is used to stop the excess flow of liquid after the drop has released. For different 

material properties, this value might need to be adjusted. Increase or decrease the negative E 

distance in the retraction command to achieve the desired retraction amount. 
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11 Troubleshooting guide 
Issue Solution 

No power  Is the small green light on the power supply turned on? 

NO 

1. Contact SE3D technical support for replacement power 
supply. 

 

YES  

1. Check wires connecting the V+ and V- terminals on the 
power supply to the controller board. Secure any loose 
connections. 

2. Contact SE3D technical support. 
 

No connection to 

computer 

To check if your computer is connected to the controller board, 

check the red light behind the Micro USB connector is lit up. The 

Pronterface application should also display the following: 

 

 
 

Almost all connection problems can be solved by following these 

steps in order: 

1. Turn off printer 
2. Unplug USB cable from computer 
3. Close Pronterface application 
4. Plug USB cable into printer and computer 
5. Open Pronterface application 
6. Connect to printer 

 

If the problem is still not solved, check the following settings in 

Pronterface: 

1. The correct port is selected 
2. The Baudrate is set to 115200 (250000 should also work) 
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For further issues, you will need to use the Arduino IDE to 

troubleshoot: 

1. With the power to the printer turned off, connect the 
controller board to your computer. 

2. Select the “Arduino Due (Native USB Port)” from the list 
of board (Tools > Board). 

3. Select the correct COM port (Tools > Port). 
4. Open the Serial Monitor and check that the Baudrate is 

set to 115200 
5. Using the command line, enter M105 (upper case M) 

- The response should be similar to this:           
 “ok T:22.3 B:21.5” 

6. If you received a response, then the printer and 
computer are communicating. 
 

Extruder does not retract 

or extrude 

If you pause or stop a print in the middle of its run, the printer 

settings can sometimes be in the relative rather than absolute 

mode, so it may not respond accordingly when you press the 

retract or extrude button. Simply reset the printer settings by 

using the command M83. Type M83 on the command line and 

press send. 

 

Droplet “skidding” across 

Petri dish after it is printed 

If you observe water droplets skidding across the petri dish after 

it is being printed, first check and see if the table surface where 

the printer is sitting on is flat. Next check to make sure that the 

table is stable. We highly recommend that the printer is placed on 

a fixed table and not one on wheels or movable.  

 

Misprints during a print If you run into “misprint” issues i.e. one or more droplets in the 

run did not get printed, it may be a needle issue due to a clogged 

or dirty needle. Remove old needle and use a new one. Calibrate 

new Z0 again before starting the new print.  

 

You should also check that there are no air bubbles in your 

syringe. If there is, turn your syringe upside down with needle 

facing up toward the ceiling and slowly push out the air bubble. 

Repeat priming step to ensure you have a tiny bulb of liquid at the 

tip of your needle before you begin, the run the protocol again.  

 

If problem persists, you can try to make adjustments on the 

protocol itself depending on what the actual problem is. We 
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recommend that you consult one of our technical staff who can 

provide recommendations and help you through the process. 

 

Printing issue related to 

droplets  

For printing issues related to droplet not forming or 2 droplets 

being released as one time, please reference the G-code 

Adjustment section above. 

 

Material not Extruding Be sure to have manually “primed” the syringe. For instructions 

on how to do this, see step 3 on page 23. 

 

Attempting to extrude with 

no tool selected 

This usually happens when you stop mid-print. Type T0 in the 

command bar and send it. 

Macro file homeall.g not 

found. 

This usually happened when the SD card in the board is little loose 

or is not recognized properly. To fix this issue: 

1. Turn off the printer 

2. Disconnect the printer in Pronterface/ Web control 

3. Unplug the USB cable from the computer 

4. Take the SD card out from the slot in the board and put it 

back in. 

5. Plug USB cable back into computer 
6. Open Pronterface/ Web control application 
7. Connect to printer 

 

 

A detailed list of general printer issues and troubleshooting techniques for our specific controller 

board (Duet board) has been compiled by RepRapPro and is available at: 

https://reprappro.com/documentation/troubleshooting-introduction/ 

 

12 Technical support  

For more technical support or issues, please email us at support@SE3D.com 

 

 

 

https://reprappro.com/documentation/troubleshooting-introduction/
mailto:support@SE3D.com
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13 Specifications 
 

WEIGHT AND DIMENSIONS 

Print bed area 120 mm x 130 mm 

Printer dimensions 18.41 cm x 25.4 cm x 34.3 cm  

 (7.25 in x 10.0 in x 13.5 in) 

Printer weight 4.5 kg (10 lbs) 

PRINT TECHNOLOGY 

 

 

Technology Extrusion-based printing system 

Extruder units Single extruder head 

Extruder temperature 

range 

N/A 

Syringes 

 

5 mL standard disposable syringes                                                                                                             

10 mL standard disposable syringes 

 

Needle tips 14 – 32 gauge with Luer lock 

Minimum volume 1.0 μL (CV = 5% at 5.0 μL) 

Viscosity range 1– 200,000 cP 

Step resolutions 10 microns 

OPERATING ENVIRONMENT Power requirements 
110 – 240V AC 
1.5A 50/60 Hz 

SOFTWARE 

Printer control software Pronterface or Duet web control 

Operating system Windows or macOS 

Connectivity microUSB or Wi-Fi 

PRINT COMPATABILITY 

Print Files STL and G-code 

Materials 
Liquids and gel-based materials 
Hydrogels and biomaterials Food 
materials (icing, etc.) 

 

 

 


